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• Shell design as per EC2 (BS EN 1992-1-1:2004) is supported. 

• Design and Checking for axial force, bending and shear can be done. 

 

midas Gen 

  Step 1. Define as a shell element   Step 2. Define the layer of Rebar and Thickness   Step 3. Run Shell Design and Checking 

Shell Design 

1. Shell Design as per Eurocode 
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midas Gen 

  Shell Design for Flexure 

In Rebar option, the followings are  
supported. 
 

1. Axial Force of Members 
2. Shear Force of Members 
3. Rebar Stress 
4. As_req (mm2/m)  
   (Required reinforcement) 
5. Rho_req  
   (Area ratio of Required reinforcement) 
6. Rebar Arrangement 
7. Design Ratio  

Result for Rebar 

Results Table 

Result for Concrete 

In Concrete option, the followings are  
supported. 
 

1. Axial Force of Members 
2. Shear Force of Members 
3. Principal Compressive Stress of  
    Concrete 
4. Design Ratio  
 

1. Shell Design as per Eurocode 
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midas Gen 

  Shell Design for Shear 

Results Table 

Result for One-Way Shear 

In One-way shear, the followings are  
supported. 
 

1. V_Ed for One-way shear 
2. Shear Resistance for Concrete 
3. Resistance Ratio 

1. Shell Design as per Eurocode 

Text Output for design results 
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1. Shell Design as per Eurocode 

midas Gen 

Design Concept of Shell Design 

Transverse shear forces 

Plate components 

Slab components 

Outer layers resist 
 bending moments 
+ membrane forces 

Inner layer resist 
the transverse shear 

• Shell or plate element subjected to membrane forces Nx,Ny,Nxy + flexural forces Mx,My,Mxy 
 

• Resisted by resultant tensile forces of reinforcement + resultant compressive forces of concrete  
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1. Shell Design as per Eurocode 

midas Gen 

Procedure of Shell Design 

Max. Compression stress < Strength   O.K. 
Uncracked 

Check plate force by analysis 

Crack Checking 

Define Sandwich model 

Cracked 

Calculate Membrane Force 

Calculate stress of reinforcement and concrete 

Define Rebar Arrangement 

Calculate strength of reinforcement and concrete 

Stress < Strength  O.K. 

: Get from ‘Plate force(UL:UCS)’ tap of Plate Stress Table 

 

 

 

 

Import Sig1, Sig2 from result table 

Yes 

Uncracked Section 

Yes 

Comp, strength 
= fcd  

No 

Comp, strength 
 

 = 0.85𝑓𝑐𝑑
1+3.80𝛼

(1+𝛼)2
 

Comp, strength ≥ Design stress   O.K. 

Sig1<0, Sig2 < 0 

(Compression stress) 
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1. Shell Design as per Eurocode 

midas Gen 

Procedure of Shell Design 

Crack Checking 

Establishing whether shell elements are cracked [EN1992-2 : 2005] 

 Uncracked,     If Φ>0.0, Cracked 

σ1 = Max. [σx, σy] = Max. [Fxx, Fyy] 

σ2 = Min. [σx, σy] = Min. [Fxx, Fyy] 

σ3 = 0 

σ3 

Plate Stress (UL : UCS) Table 
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1. Shell Design as per Eurocode 

midas Gen 

Procedure of Shell Design 

Define Sandwich model 

• Use ‘ 0.2*h’ as default value.  
 

• If check on “ Consider Iteration for optimal design”,  
      layer thickness will be calculated automatically.  
      if it does not converge, Limit Thickness will be used.  

Sandwich Thickness 

Calculate Membrane Force 

• The geometry of sandwich element has to be known to compute the membrane forces (Nxk, Nyk, Nxyk). 
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1. Shell Design as per Eurocode 

midas Gen 

Procedure of Shell Design 

Calculation of Sandwich Thickness for Optimal Design - 1 

k=compression layer 

j = tension layer 

ck0 : 1st estimation of ck 

ck : the depth of the compression block 

Check  main moment 

Define Comp. / Tens. by sign of moment 

Cal. of Resultant moment, Ma 

Cal ck0 by Equations 
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1. Shell Design as per Eurocode 

midas Gen 

Procedure of Shell Design 

k=compression layer 

j = tension layer 

Membrane force in compression layer. 
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Compression Force of Concrete . 
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1. Shell Design as per Eurocode 

midas Gen 

Procedure of Shell Design 

Calculation of Membrane Force in tension layer and Required Rebar Area 

Calculate membrane force in tensioned layer. 

Calculate Comp. forces in reinforcement in compressed layer. 

In Gen, Ignore Comp. forces in reinforcement (Required rebar Area by comp. is 0) 

Calculate tension forces in reinforcement in tension layer. 

Areq,x = Nxaj / fyd 

 

Areq,y = Nyaj / fyd 

Calculate required Rebar Area in tension layer. 
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1. Shell Design as per Eurocode 

midas Gen 

Procedure of Shell Design 

Calculate Force of reinforcement(Tension Layer) and concrete(Compression Layer) 

Nxk 

Nyk 
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Nxak, Nyak : tension forces in reinforcement placed in x and y direction in layer k 

Nck : Concrete compression force in layer k 
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1. Shell Design as per Eurocode 

midas Gen 

Procedure of Shell Design 

Modification of Tension force by considering the location of rebar 

Distance from center section to center of outerRebar 

Distance from center section to center of sandwich thickness 
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2. Modeling for Drop Panel and Column Capital 

midas Gen 

Drop Panel : Node/Element > Flat/Plate Structure > Drop Panel 

Step 1 : Define Drop Panel Step 2 : Assign Drop Panel 

Select Columns  

and Click ‘Apply’ 

When modeling a slab by ‘Auto-mesh’ function,  

the defined drop panel generates automatically.  

Step 3 : Apply Auto-mesh 
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2. Modeling for Drop Panel and Column Capital 

midas Gen 

Column Capital : Node/Element > Flat/Plate Structure > Column Capital 

Step 1 : Define Drop Panel Step 2 : Assign Drop Panel and run “Auto mesh” 

When modeling a slab by ‘Auto-mesh’ function, 

It is considering size of column capital and 

defining the rigid link for nodes in column capital 

Step 3 : Apply Auto-mesh 

Rigid Link is defined for nodes  

of column capital automatically 

Auto-Mesh considered size of column capital 
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3. Construction Stage Analysis considering Material Nonlinearity 
• Construction stage analysis with material nonlinear is supported  

• Plastic model for material can be defined in dialog box of ‘Plastic Material’ and ‘Material Data’ 

midas Gen 

  Step 1. Define Plastic Material Data   Step 2. Define Material Nonlinear   Step 3. Define Construction stage analysis Option 

Setting for Construction Stage Analysis with Material nonlinear 

Linear Model  

(Max. for sig_eff =2.5N/mm2) 

Material nonlinear Model  

(Max. for sig_eff =5.4N/mm2) 
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4. Addition of artificial earthquake generation function of dynamic analysis 
• Spectral load and time history load used for dynamic analysis (Response Spectrum Analysis and Time History Analysis) 

can be generated as artificial seismic waves. 

• It is possible to apply dynamic load with various variables through artificial earthquake generation referring to Design 
Spectrum according to country code. 

 

midas Gen 

artificial earthquake : Tools > Data Generator > Artificial Earthquake  

 

Design Spectrum Generation of Artificial Earthquake 
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5. Reinforcement data interchange between Gen and GSD 
• Addition of the function to link rebar input data to Gen column with GSD. 

• Improvement of GSD design process (Interaction Curve and Moment Curvature Curve) through convenient 
reinforcement input function of Gen.  

midas Gen 

Rebar input in Gen  Reinforcement data interlock between Civil and GSD 

Design > RC Design > Beam Section Data for Checking 

Design > RC Design > Column Section Data for Checking 
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6. Revit 2018 Interface 

•Using Midas Link for Revit Structure, direct data transfer between midas Gen and Revit 2018 is available for Building Information 
Modeling (BIM) workflow. Midas Link for Revit Structure enables us to directly transfer a Revit model data to midas Gen, and  
deliver it back to the Revit model file. This feature is provided as an Add-In module in Revit Structure and midas Gen text file 
(*.mgt) is used for the roundtrip 

midas Gen 

  Functions Revit <> Gen 

Linear  

Elements 

 Structural Column   <> 

 Beam   <> 

 Brace   <> 

 Curved Beam   > 

 Beam System   > 

 Truss   > 

Planar 

 Elements 

 Foundation Slab   <> 

 Structural Floor   <> 

 Structural Wall   <> 

 Wall Opening & Window   > 

 Door   > 

 Vertical or Shaft Opening   > 

Boundary 

 Offset   > 

 Rigid Link   > 

 Cross-Section Rotation   > 

 End Release   > 

 Isolated Foundation Support   > 

 Point Boundary Condition   > 

 Line Boundary Condition   > 

 Wall Foundation   > 

 Area Boundary Condition   > 

Load 

 Load Nature   > 

 Load Case   > 

 Load Combination   > 

 Hosted Point Load   > 

 Hosted Line Load   > 

 Hosted Area Load   > 

Other  

Parameters 

 Material   <> 

 Level > 

Send Model to midas Gen 

Revit 2018 Gen2018 

 File > Import > midas Gen MGT File 

 File > Export > midas Gen MGT File 
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7. Member Design as per NTC 2018 

Concrete Design Code 

midas Gen 

Seismic Load Specification User input for Strut angle for concrete shear resistance 

Only for Beam & Column 
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7. Member Design as per NTC 2018 

• Add serviceability stress checks for ‘Quasi Permanent’ 

load combination 

midas Gen 

• Add plot of  VRd,max, VRd,s when VRd,c <1 

Detail report 

Graphic report 

Classification of load combinations 

(C : Characteristic   Q : Quasi-permanent) 
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7. Member Design as per NTC 2018 

• Detail Report for Punching Shear Checking as per 6.4.4 

and 6.4.5 of UNI EN1992‐1‐1  (Scheduled for June) 

midas Gen 

• Remove the default "flag" for Beam-Column Joint Design  

   Calculating “Area(Asw) / space(Sr)” of shear reinforcement. 

   as per SS-EN 1992-1-1:2005/A1:2014 
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7. Member Design as per NTC 2018 

Location in NTC 2018 Details  

7.2.5  Minimum rebar ratio for mat foundation modifies the limit from 0.2% to 0.1% 

7.4.4.5.1 When checking Wall element, it is not supported to apply ± 50%N for design of wall. 

7.4.6.2.4 
Minimum Rebar Ratio for Wall Element and Plate Type Wall (ASWD) will be modified  
as As/Ac = 0.002 (Vertical and Horizontal) 

7.4.6.2.2 Construction details for Ductility for column 

7.4.6.2.4 Construction details for Ductility for wall 

7.4.4.1.2 

Update formula for Check of Ductility:         
 

midas Gen 



midas Design+ 
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[Effective Area Method] 

1. Steel Design as per Eurocode 
• Supports steel beam and column design as per per EC3 (BS EN 1993-1-1:2005) 

• Steel design supports only H-shape. 

Design+ 

- Print the summary report and detail report as MS word or Text file 

- Torsion check and serviceability limit state check are not supported 

- Import Member data and force data from Gen by Midas Link 

- Drawing the member list 

Checking item for Ultimate Limit State 

Compression resistance 

Bending Moment resistance 

Shear (by Shear Buckling) resistance 

Bending and Shear resistance 

Bending and Axial force resistance 

Bending, Shear and Axial force resistance 

Flexural buckling resistance 

Torsional and Torsional-flexural buckling 

• Resistance of cross-section 

• Buckling resistance of members 

Lateral torsional buckling resistance 

Uniform member in bending and compression 

Steel Design as per Eurocode 
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[Effective Area Method] 

2. Addition of EC N.A. for RC Design 
 • National Annex of Singapore and Sweden is added 

Design+ 

Additional Design Information for Sweden and Singapore 

- If click “Code Table”, You can see a comparison table for each NA. 

EC2 NationalAnnex Table.pdf
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[Effective Area Method] 

3. Copy & Paste function in Member List table 
• We can copy the value of the member list table to SW such as Excel, and simply edit the model data by 

pasting the modified value into the Member list table.   

Design+ 

Design+ : Member List 

Excel or other SW for edit 


